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from the use of this document.
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Preface

How to Use This Guide

Purpose of This
Guide

This guide is written for the training of principal investigators and laboratory staff 
who operate and maintain the Applied Biosystems 3730/3730xl DNA Analyzers.

Assumptions This guide assumes that you have:

• Familiarity with the Microsoft® Windows® 2000 and/or Microsoft® Windows 
XP Professional operating systems. 

• Knowledge of techniques for handling and preparing DNA samples for 
sequencing.

• A general understanding of hard drives and data storage, file transfers, and 
copying and pasting.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for emphasis. For 
example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a 
drop-down or shortcut menu. For example:
Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All Runs.

User Attention
Words

Two user attention words appear in Applied Biosystems user documentation. Each 
word implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the 
use of the product.

IMPORTANT! Provides information that is necessary for proper instrument 
operation, accurate chemistry kit use, or safe use of a chemical.
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vi Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you need a valid Oracle 
user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet for each 96-well 
plate.

Safety Alert
Words

Safety alert words also appear in user documentation. For more information, see “Safety 
Alert Words” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started 
Guide (PN 4359476).

How to Obtain More Information

Related
Documentation

The following related documents are shipped with the system:

• The Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide – 
Provides step-by-step procedures for analyzing DNA samples. It is designed to help 
you learn to use the 3730/3730xl DNA Analyzer.

• The Applied Biosystems 3730/3730xl DNA Quick Reference Card – Provides a 6-
page overview for using a 3730/3730xl DNA Analyzer. It is designed to help you 
find information quickly.   

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

mailto:techpubs@appliedbiosystems.com
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How to Obtain Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 

other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers 
to contact Applied Biosystems Technical Support and Sales facilities.

http://www.appliedbiosystems.com
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Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide 1

Chapter 1

Notes

1Maintenance

Maintenance Schedules

Overview This section summarizes common tasks required to maintain your Applied Biosystems 
3730/3730xl DNA Analyzer in good working condition. The tasks are organized 
according to how often you should perform them.

 Wear appropriate protection, including gloves, laboratory goggles, 
and coat whenever you work with the fluids used on this instrument or parts that may 
come into contact with these fluids.

CHEMICAL HAZARD. Running Buffer with EDTA causes eye, 
skin, and respiratory tract irritation. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, clothing, and gloves.

CHEMICAL HAZARD. POP-7 polymer causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Daily
Maintenance

 Task Frequency

Ensure that adequate levels of liquid are in the buffer, waste, and water 
reservoirs.

Before each run

Ensure the plate assemblies are properly assembled. 

IMPORTANT! The holes in the plate retainer must align with the holes in 
the septa, or the capillary tips will be damaged. Make sure the retainer clips 
are flush with the sides of the plate.

Before each run

Ensure the plate assemblies are properly positioned on the plate deck. 
Plates should sit snugly on the deck. 

IMPORTANT! Never use warped plates.

Before each run

Check the level of buffer in the buffer jar and ensure that the overflow hole 
is not blocked, and that the overflow hole is facing toward the front of the 
instrument.

Before each run
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2 Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Notes

Weekly
Maintenance

Monthly
Maintenance

As-Needed
Maintenance

Replace the buffer in the buffer jar, the water in the water reservoir, and 1✕ 
run buffer in the buffer reservoir on the instrument and, make sure that the 
outside of the assemblies are dry.

Every 48 hours

Check for bubbles in the pump block, lower polymer block, interconnect 
tube, polymer supply tube, and channels.

Remove all bubbles using the Bubble Remove wizard (see page 5) .

Daily or 
before each run

Check the loading-end header to ensure that the capillary tips are not 
crushed or damaged.

Daily or
before each run

Check the level of polymer in the bottle to ensure that the volume is 
sufficient for runs.

Daily or
before each run

Check the pump block and the lower polymer block to ensure that they fit 
securely on the instrument.

Daily

Clean the instrument surfaces. Daily

Check for leaks around the array knob, interconnect tubing nuts, and check 
valve.

Daily

 Task Frequency

Task Frequency

Replace the POP-7 polymer using the Change Polymer wizard. Weekly

Check the storage conditions of the used arrays. Weekly

Replace reservoir septa. Weekly

Clean the buffer jar, water, waste, and buffer reservoirs with warm water 
followed with a thorough distilled/deionized water rinse.

Weekly

Flush the polymer delivery pump water trap (see page 10). Weekly

Task Frequency

Run the Water Wash wizard (see page 5).

Flush the array port during the Water Wash wizard, whether or not bubbles 
are present in the array port.

Monthly or as 
needed

Task Frequency

Clean the drip tray. As needed

Change the capillary array using the Install Array wizard (see page 5). As needed

Remove any dried polymer from the capillary tips. Use a lint-free wipe 
moistened with deionized water.

As needed
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Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide 3

Notes

1

General
Instrument

Cleaning

To clean the instrument:

1. Ensure the oven door, the instrument door, and the stacker are closed.

2. Press the Tray button on the front of the instrument to move the autosampler to the 
forward position.

3. Wipe off any liquid on or around the autosampler using a lint-free tissue.

4. Clean out the drip tray with deionized water and lint-free tissue.

5. Clean off any polymer build-up (crystals) on the instrument including the capillary 
tips with deionized water and lint-free tissue. 

IMPORTANT! Never use organic solvents to clean the instrument or any of 
its components.

Wizards Types
and Functions

The five wizards in the Data Collection Software v3.0 guide you through several 
maintenance procedures. Access the Wizard drop-down menu by selecting: 
GA Instruments >ga3730 >Instrument Name.

 

Wizard When to Use

Install Array • To install a capillary array:

– On a new instrument

– To reactivate an instrument that has been shut down

• To replace an installed capillary array with another capillary array

• To enter array information when the Data Collection software is 
reinstalled or upgraded

Change Polymer • To replenish the polymer supply 

• To replace the polymer in the polymer delivery pump with polymer of 
the same or different lot

• To enter polymer information when Data Collection software is 
installed or upgraded

Bubble Remove • To remove bubbles in the polymer delivery pump chamber, 
channels, array ferrule, and tubing
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4 Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Notes

Water Wash • To wash the polymer delivery pump chamber, lower polymer block*, 
channels, and tubing with water:

– As part of a monthly maintenance protocol

– To remove any suspected contaminants in the polymer delivery 
pump

– To remove persistent bubbles (followed by the Bubble Remove 
wizard, if needed)

– To replace old polymer in the polymer delivery pump

* The lower polymer block should not be removed; clean on the 
instrument using this wizard.

Instrument 
Shutdown

• To prepare the instrument for a period of disuse of greater than one 
week

• To remove the array

Wizard When to Use
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Notes

1
Typical Conditions for Using Maintenance Wizards

Condition Applicable Wizard/Action Description

The polymer has 
been in the pump 
longer than 1 week.

Use the Water Wash wizard (instead 
of Change Polymer wizard) to replace 
the polymer.

Using the Water Wash wizard ensures that the system is 
well cleaned before fresh polymer is introduced. 

Certain polymer components may decompose, causing an 
increase in electrophoresis current in polymer that has 
been at room temperature for more than 1 week.

Bubbles move but 
are not completely 
cleared by the 
Bubble Remove 
wizard.

Use the Bubble Remove wizard 
repeatedly until the bubbles are 
gone.

When clearing bubbles with repeated use of the wizard, 
note whether or not the target bubbles move during the 
wizard procedure. Any bubbles that move but are not 
entirely cleared by running the wizard are likely to be 
cleared with a repeat of the Bubble Remove wizard.

You want to clear 
persistent bubbles

Try one or both of the following:

• Run the Water Wash wizard 
followed, if necessary, by the 
Bubble Remove wizard. 

• Remove the polymer bottle and 
then run the Bubble Remove 
wizard (a large amount of air is 
drawn into the pump chamber and 
other parts of the system). 
Reinstall the polymer bottle and 
repeat the Bubble Remove wizard 
to remove all bubbles.

• The Water Wash wizard includes refilling the pump with 
polymer.

• If the pump sits idle for a time, bubbles that previously 
did not move are often cleared by running the Bubble 
Remove wizard.

Many or large 
bubbles are present 
in the pump 
chamber.

The Water Wash wizard may help to 
remove bubbles.

No bubbles are 
present in the array 
port during the 
monthly water wash 
procedure.

You should still perform the Flush 
Array Port procedure using the Water 
Wash wizard as part of monthly 
maintenance, even if no bubbles are 
present. 

Occasional flushing of the array port keeps this space filled 
with fresh solution.

You want to install a 
capillary array on an 
instrument without 
an array.

Use the Install Array wizard. Filling the array helps to ensure complete changeover to 
polymer after the polymer delivery pump has been washed 
with water.

You want to remove 
or install a capillary 
array.

Carefully follow the instructions in the 
appropriate wizard (Install Array or 
Instrument Shutdown wizard). 

Ensure that the instrument 
configuration and the database 
information agree.

A mismatch between the array configuration/identification 
and the database information may cause incorrect analysis 
parameters and result in reduced basecalling accuracy.

You select Discard 
during installation of 
an array using the 
Install Array wizard.

The information for that array cannot 
be entered again on the instrument.



D
R

A
FT

A
p

ril
 7

, 2
00

5 
2:

21
 p

m
, 3

73
0M

T_
01

_M
ai

nt
en

an
ce

.fm

Chapter 1 Maintenance
Typical Conditions for Using Maintenance Wizards

6 Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Notes

You plan to leave 
the instrument 
unused for more 
than 1 week.

Use the Instrument Shutdown wizard.

You are using the 
Install Array wizard 
to reactivate the 
instrument.

First power on the instrument power 
to activate the wizard menu in the 
Data Collection software.

The instrument must be powered on for the wizards to be 
available through the Data Collection software. If the 
instrument is turned off, the wizard names in the drop-
down menu are grayed out.

You cancel a wizard 
during an 
automated 
procedure.

Wait until wizard step is complete. The piston cannot stop immediately. During the period 
between cancellation and termination while the piston is in 
motion, a “Please wait...” dialog box displays.

You want to clean 
the polymer delivery 
pump 

Use the Water Wash wizard with 
deionized water at ≤ 40 °C.

Hot water may damage the polymer delivery pump seals 
and joints. Do not use any solutions or fluids in the 
instrument other than water and polymer.

Condition Applicable Wizard/Action Description
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Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide 7

Notes

1

Effects of the
Instrument Door
State on Wizard

Tasks

Follow the suggestions below to use the wizards effectively when the door is open or 
closed.

IMPORTANT! Whenever the door is closed (whether or not a wizard is open, or an 
automated procedure is in progress), the autosampler moves while determining position 
(initialization). Always wait for the autosampler to stop moving, and the green status 
light to illuminate before starting any automated procedures. If you accidentally start an 
automated procedure while the autosampler is moving, an error may be displayed in the 
Data Collection Software event window. However, you should be able to complete the 
wizard. Restart the instrument and the Data Collection software. 

Wizard-Based Task Status of 
Instrument Door Result

IMPORTANT! Do not open or close the instrument door while an automated procedure is in progress. Leave the door in 
the starting state (whether open or closed) until the automated procedure is complete.

Begin an automated 
procedure 

Open The procedure continues when the door is closed, and after the 
autosampler moves to initialize. If you open the door again, the 
procedure pauses until the door is closed.

Begin an automated 
procedure 

Closed The procedure pauses if the door is opened. Close the door again to 
resume the procedure.

Click Fill Array Open The procedure does not start; the door must be closed.

Perform an automated 
procedure 

Closed The green status light remains on (not flashing).

Perform an automated 
operation

Open
The yellow status light flashes.

Note: Regardless of whether or not automated procedures are in progress during wizard use, if the instrument door is:

• Closed, then the green status light remains on (not flashing)

• Open, then the yellow status light flashes
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8 Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Notes

Cleaning the Polymer Delivery Pump (PDP) and 
Lower Polymer Block 

Guidelines

CHEMICAL HAZARD.       
POP-7™ polymer may cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for 
research and development purposes only.

• Do not expose the polymer blocks to organic 
solvents.

• Do not use sharp or pointed instruments to 
remove dried polymer from the polymer blocks. 

• Do not use water >40 °C to clean the polymer 
blocks.

Frequency

• Clean the exterior every 7 days, when polymer is 
replenished.

• Flush the polymer delivery pump water trap once 
per week.

• Clean the polymer delivery pump chamber, 
channels, and tubing once per month.
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Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide 9

Notes

1

Cleaning the Polymer Delivery Pump 
Chamber, Channels, and Tubing

1. Run the Water Wash wizard by selecting 
Wizards > Water Wash Wizard on the menu 
bar. 

2. Inspect the channels of the Pump and Lower 
blocks for any contaminants. Repeat the Water 
Wash wizard until contaminants are removed. 

Pump block

Lower block

40 °C DI water 
bottle. Use DI 
water only.
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Notes

Flushing and Filling the Water Trap

CHEMICAL HAZARD. POP-7 polymer causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Overview

The polymer delivery pump water trap should be flushed at least once per week to wash 
out any diluted polymer that may have passed through the water trap seals. Some air 
bubbles in the water trap are acceptable and do not affect performance. Leave the trap 
filled with either distilled or deionized water.

To flush the water seal trap:

1. Fill the supplied 20mL, all-plastic Luer lock syringe (PN 4324463) with distilled or 
deionized water. Expel any bubbles from the syringe. 

Note: Do not use a syringe smaller than 20 mL. A smaller syringe may generate 
excessive pressure within the trap.

2. Attach the syringe to the forward-facing Luer fitting at the top of the pump block. 
Hold the fitting with one hand while threading the syringe onto the fitting with the 
other hand.

3. Open the Luer fitting by grasping the body of the fitting and turning it and the 
attached syringe approximately one-half turn counterclockwise.

4. Open the exit fitting at the top left side of the pump block by turning it 
approximately one-half turn counterclockwise.

5. Hold an empty tube or beaker under the exit fitting to receive approximately 5 mL 
of waste. Flush the trap by pushing steadily on the syringe plunger.

IMPORTANT! DO NOT USE EXCESSIVE FORCE. Take approximately 30 
seconds to flush 5 mL of either distilled or deionized water through the trap.

6. Close the fittings by turning each clockwise, in the following order, until the fittings 
seal against the block:

a. Luer fitting.
b. Exit fitting.

IMPORTANT!: Do not over-tighten the fittings. The fittings require only 
enough tightening to prevent water leaks. Excessive tightening can damage the 
fittings.
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Notes

1

7. Remove the syringe from the Luer fitting. Hold the fitting with one hand while 
turning the syringe counterclockwise with the other hand.
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Notes

Storing a Capillary Array

To maintain serviceability during 
storage and to prevent damage to the arrays, keep both 
ends of the capillary array immersed in 1✕ run buffer. 
Failure to do so may result in array damage.

CHEMICAL HAZARD. 
Running Buffer with EDTA causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

1. Remove the capillary array from the instrument 
using the Install Array wizard.

IMPORTANT! Do not choose Discard Array if the 
array will be used again.

2. Put 80 mL of 1✕ run buffer in the capillary array 
header shipping cover.

3. Lower the capillary tips of the array header into 
the shipping cover and lock the header onto the 
cover. The tips of the capillaries should be 
immersed in buffer.

4. Clip the detection cell window cover onto the 
detection cell.

5. Attach the detection cell with its cover to the 
storage post on the array frame.

6. If the array knob and double-tapered ferrule are 
on the array tip:

a. Remove them and rinse them with 
deionized water.

b. Dry the parts with a lab wipe.
c. If they are not to be used immediately, store 

them in a safe place.

7. Clean the array tip carefully with a lab wipe 
moistened with deionized water.
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Notes

1

8. Attach the array tip shipping vial filled with 1✕ 
run buffer to the array tip. Loosen the vial cap 
slightly, insert the tip and then tighten the cap.

9. Clip the vial with the array tip onto the array 
frame.

10. Store the capillary array upright in a safe area.

IMPORTANT! Check the 1✕ run buffer levels in 
the shipping cover and vial at least once a week; 
replenish the buffer as necessary to keep both 
ends of the capillaries immersed in buffer.
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Notes

Performing a Short-Term Shutdown
Perform the short-term shutdown procedure if you 
will use the instrument again in 7 days or less.

CHEMICAL HAZARD. 
POP 7™ polymer may cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for 
research and development purposes only.

CHEMICAL HAZARD. 
Running Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Materials Required

• 1✕ Run Buffer 
• POP-7 polymer
• Deionized water
• Lab wipes
• Gloves
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Notes

1

Performing a Short-Term Shutdown

1. Close the instrument door.

2. Press the tray button to bring the autosampler to 
the forward position.

3. After the autosampler stops moving and the 
green status light illuminates, open the 
instrument door.

4. Remove the buffer, water, and waste reservoir 
assemblies from the instrument.

5. Disassemble each reservoir assembly and empty 
the contents of the reservoirs into an aqueous 
waste container.

6. Rinse each reservoir using deionized water.

7. Dry the reservoirs using lint-free wipes.

Instrument door

Tray
button

Status 
lights

Aqueous 
Waste

DI H2O ≤ 40 °C
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Notes

8. Fill and assemble the reservoirs.

9. To prevent damage to the capillary array, inspect 
each reservoir assembly and verify that the:

• Septa fit snugly and flush on the reservoir

• Rubber gasket around the edge of the 
reservoir cap is seated

• Plate retainer holes and the septa strip are 
aligned

10. Dry the reservoirs using lint-free wipes.

Buffer Reservoir Assembly Water and Waste Reservoir Assemblies

1. Fill the buffer reservoir with 80 mL of 1✕ running 
buffer.

2. Assemble the reservoir assembly as shown below: 

1. Fill the water and the waste reservoirs with 80 mL of 
deionized water.

2. Assemble each reservoir assembly as shown below: 

GR2210

Retainer

Septum

Reservoir cap

Reservoir

Heated plate base

Power cable

Retainer

Septum

Reservoir cap

Reservoir

Plate base

Rubber gasket 
not seated 
correctly

Plate retainer 
holes and septa 
holes are not 
aligned

Lint-free wipe
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Notes

1

11. Connect the Buffer reservoir plate base cable to 
the heater outlet within the instrument.

IMPORTANT! After placing the buffer reservoir, 
make sure the cable is out of the way of the 
autosampler

12. Place the Water and Waste reservoirs in the 
instrument. Load the three reservoirs in the 
following order:

a. Buffer reservoir 
b. Water reservoir 
c. Waste reservoir 

13. Close the instrument door.

14. Press the instrument tray button.

15. Press the instrument power button.

Buffer position

Buffer reservoir

12a 12b 12c

Instrument door

Tray button

Power
button
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Notes

16. Power off the computer:
a. Select > Shutdown.
b. In the Shut Down Windows dialog box, 

select Shut down from the drop-down list.
c. Click .
d. Press the monitor power button.

16b

16c
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Notes

1
Deleting Data from the Database 

IMPORTANT! The Cleanup Database utility deletes 
all run data and plate records in the database. Before 
running the utility, be sure that all runs have been 
extracted from the database.

IMPORTANT! Do not manually delete spectral plate 
records or spectral information--doing so permanently 
deletes spectral information.

1. In the navigation pane of the Data Collection 
Software, click 

GA Instruments > Database Manager.
The Database Manager opens.

2. Click Cleanup Processed Plates.
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Notes

The Cleanup Database dialog box opens.

3. Click .

Note: You do not need to reimport the spatial 
and spectral calibrations or the custom run 
modules.

Note: It may take several minutes to clean up the 
database.
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Notes

1
Maintaining Adequate Space for Database and Sample Data

To ensure that you have sufficient disk storage space, you need to regularly:

• Archive data, see page 23
• Delete unneeded files, see page 22
• Empty the recycle bin
• Defragment the drives, see page 24

Pre-Run
Automatic Disk
Space Checks

Before a run or batch of runs, the Data Collection software automatically checks if 
sufficient space is available to store the database and sample file data you create. 

The Data Collection software displays a warning message to remove data and/or clean 
up the database when the database is full. The message displays in the Error pane of the 
Instrument Status window and in the Event Log window. Also, the status light in the 
bottom left corner of the data collection window flashes red.

Full Database
Error

To view error messages, click GA Instruments > ga3730 > 
your instrument name >Instrument Status> Event Log.

IMPORTANT! Runs can not be started until the data is removed from the drive and/or 
database is cleaned up.

Status light
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Notes

Checking Available Disk Space on Drive E

1. In the navigation pane of the Data Collection 
Software, click 

GA Instruments > Database Manager.
The Database Manager opens.

2. If there is insufficient space on drive E:
a. Archive the sample files to a CD-RW (see 

page 23) or another volume.
b. Delete the sample file data from the drive E 

and then empty the Recycle Bin.

Check disk space status here
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Notes

1

Archiving Data

Creating a Data CD

Use the Roxio Easy CD Creator™ 5 software that 
came with your Dell™ computer. Use this software to 
archive data to a CD. The software is also part of the 
CD set you received with your Dell computer.

To archive data:

1. Select Start > Programs > Roxio Easy CD 
Creator 5 > Applications > Easy CD Creator.

The Untitled - Easy CD Creator dialog box 
opens.

2. For help creating a data CD, select Help > 
Contents and Index.

3. In the navigation pane, select Making Data CDs 
for Archiving and Sharing > Making a Data 
CD.

4. Follow the instructions for creating the CD.
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Notes

Defragmenting the Computer Hard Drive
Because fragmentation of files decreases the 
performance of both the data collection software and 
the computer operating system, defragment the 
computer hard drive:

• At least once every month.
• Before fragmentation reaches 10%.

Defragmenting the Hard Drive

1. In the Windows desktop, select 
Start >Programs > Accessories >System Tools 
>Disk Defragmenter.

2. Select drive E.

3. Click .
The Defragmentation Complete dialog box when 
defragmentation is complete.

4. In the Defragmentation Complete dialog box, 
click .

5. In the Computer Management dialog box, 
click .
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Chapter 2

Notes

2

Troubleshooting

Spatial Calibration 

Peak Does Not
Contain an

Orange Cross

IMPORTANT! If the pluses are not placed at the tip of each peak the data quality may be 
compromised.

Note: The cross positions cannot be altered after you accept the calibration data.

To move an orange cross: 

1. Magnify the view of the peak without a cross.

2. Determine the peak pixel position.

3. Change the value for the incorrectly positioned cross. 

4. Click outside of the box.

If the Calibration
Fails

If the calibration fails, or if you do not like the appearance of the profile, perform the following procedure:

CHEMICAL HAZARD. Methanol is a flammable liquid and vapor. Exposure causes 
eye and skin irritation, and may cause central nervous system depression and nerve damage. Read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves

1. Repeat the spatial calibration (see “Performing Spatial Calibration” in the Applied Biosystems 
3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

2. If the calibration fails again:

a. Follow the Bubble Remove wizard to remove bubbles and to fill the capillaries with polymer.

b. Repeat the spatial calibration (see “Performing Spatial Calibration” in the Applied Biosystems 
3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

Change the cross position



D
R

A
FT

A
p

ril
 5

, 2
00

5 
2:

25
 p

m
, 3

73
0M

T_
02

_T
sh

oo
t.

fm

Chapter 2 Troubleshooting
Spatial Calibration

26 Applied Biosystems 3730/3730xl DNA Analyzer Maintenance and Troubleshooting Guide

Notes

3. If the calibration fails again:

a. Open the instrument door.

b. Open the oven door.

c. Open the detection cell door and then turn the cam knob 1/4-turn clockwise (pointer left).

d. Pull the pump and lower polymer blocks forward until the detection cell comes out of the 
detection block.

e. From the pump block remove the:

– Tip of the capillary array
– Array knob
– Ferrule

f. Add one drop of methanol to a sterile swab or lint-free wipe and then use the swab or wipe 
to gently clean the front surface of the detection cell.

g. Reinstall the tip of the capillary array, array knob, and ferrule into the pump block.

h. Push the pump and lower polymer blocks back against the pump panel, making sure that 
the buffer valve lever properly engages the buffer pin valve.

i. Carefully place the detection cell into the detection block and then secure it by rotating the 
cam knob 1/4-turn counterclockwise (pointer down).

j. Close the detection cell door.

k. Close the oven door.

l. Close the Instrument door.

m. Using the Bubble Remove wizard, remove all bubbles. Pay particular attention to the array 
port area.

n. Repeat the calibration (see “Performing Spatial Calibration,” in the Applied Biosystems 
3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

4. If the calibration fails again:

a. Perform steps 3a through 3c.

b. Reposition the capillary array window in the detection cell.

c. Perform steps 3j through 3m.

d. Repeat the calibration (see “Performing Spatial Calibration,” in the Applied Biosystems 
3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

5. If calibration fails again, replace the capillary array. For help see, Repeat the calibration (see 
“Installing the Capillary Array,” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting 
Started Guide PN 4359476)

GR2193

Front surface of the detection cell
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Notes

2

General Troubleshooting

Symptom Possible Cause Corrective Action

No signal Incorrect sample 
preparation

Replace samples with fresh samples prepared with fresh  
Hi- Di™ formamide.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It is a 
possible reproductive and birth defect hazard. Read the 
MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Air bubbles in sample tray Centrifuge samples to remove air bubbles.

Spectral calibration fails, or 
“No candidate spectral files 
found” message displayed

Clogged capillary Refill the capillaries using manual control. Look for clogged 
capillaries during capillary fill on the cathode side.

Insufficient filling of array Check for broken capillaries and refill the capillary array.

Expired spectral standards Check the expiration date and storage conditions of the 
spectral standards. If necessary, replace with a fresh lot.

Spikes in the data Expired polymer Replace the polymer with a fresh lot using the Change 
Polymer Wizard.

CHEMICAL HAZARD. POP-7™ polymer 
causes eye, skin, and respiratory tract irritation. Read the 
MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Air bubbles, especially in 
the polymer

• Refill the capillaries using the Bubble Remove wizard.

• Bring the polymer to room temperature.

• Replace expired polymer.

Possible contaminant in the 
polymer

Replace the polymer using the Change Polymer wizard.

Instrument fittings leak Finger-tighten all fittings. Do not overtighten. 

Brown or black deposits in 
the lower polymer block

or,

Burnt smell around the 
lower polymer block

• Arcing

• Bubbles in the tubing or 
in the polymer block.

Replace the lower polymer block.

Air bubbles Loose fittings Use the Bubble Remove wizard. For persistent bubbles, 
change the system over to water, then back to polymer 
using wizards.
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Notes

Polymer in the buffer jar 
during filling (Schlieren lines, 
polymer streaking into 
buffer)

• Leaking buffer pin valve

• Arcing

• Adjustment needed

Contact Applied Biosystems to have a Service Engineer 
adjust the pin valve.

or,

Replace the lower polymer block.

Polymer comes out of the 
polymer tubing during pump 
fill stroke. 

Check valve leaks. Remove 
the polymer bottle to see 
the check valve.

Remove the pump from the instrument and push 100 mL of 
DI-water through the check valve with a 50-cc syringe and 
adapter.

“Tray on deck does not 
match Tray Type in run 
setup” error message 
displayed.

Contact Applied Biosystems to arrange a Service Engineer 
visit.

Symptom Possible Cause Corrective Action
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